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*************************************** 

Tell Me a Story . . . 

by Curt B. Witcher 

*************************************** 

Numerous times in the past, this ezine has declared and described the importance of story--

discovering our stories and telling our stories. As we approach Thanksgiving Day 2014 as well as the 

many December and January celebrations after that, it’s appropriate to illuminate again the power 

and consequence of story. The gatherings at these times of year, with their laughter and 

conversations, and sometimes dampened eyes, are really all about the stories we share. Wherever 

and whenever families gather, stories are among those special things that bind them together. As 

with a woven piece of cloth, these stories become the fabric of our lives and are the vehicles 

through which we tell others about who we are. And at the end of the day, that is what we do as 

family historians--we discover and recall, preserve, and pass-on the stories that articulate who we 

are, whence we came, and what events guided the course of our lives.  

 

Somewhat regularly when individuals are first exposed to genealogy and family history pursuits, 

whether they are actually making a commitment to get involved or just observing activities of those 

who are engaged, those goings-on can seem complicated, overly-detailed, and, let’s face it, a tad bit 

intimidating. All that searching, all those copies (on paper or virtually) of seemingly endless 

documents and data types, all the buzz over newly offered online databases, all of it certainly can 

lead one to wonder what this genealogy “stuff” is all about. In my opinion, the easiest, most 

straight-forward, and assuredly the most enticing, way to describe what we are doing as 

genealogists is to say we’re finding and telling our stories. Even the uninitiated will quickly 

understand, and likely be rather unable to resist getting involved in finding and telling their stories.  

 

It is easy to overlook how significant story can be in our lives. How many of us can recall the 

requests of children and grandchildren to “tell me a story?” Knowingly or not, we gave a part of 

ourselves to them when we told them about our school days, the automobiles of yesterday, our early 

work lives, and those “interesting” hairdos. Stories are discovered, created and shared in so many 



different ways, and nearly always their impact is of great consequence.  

 

My paternal grandfather died years before my parents were even married, and I know him only 

through the stories I have been told. Indeed, there are stories about learning the stories of good 

ol’ Valentine Witcher. A favorite is the story of a week-long visit my older brother and I were 

fortunate to have at our paternal grandmother’s home in Jasper, Indiana when we were just little 

boys. Our parents had given Grandma strict instructions about our bedtimes (which of course we 

believed were terribly and unreasonably too early!). So we hatched a grand plan (at least in our 

minds!) one evening to see how long we could get Grandma to talk as she was tucking us in for the 

night--how long we could blow past our official bedtime. We decided to ask her about Valentine. 

Every little snippet led to another question or two. We were fascinated both by what Grandma was 

telling us about Valentine, and by the fact our plan was working. It was nearly midnight before the 

lights were out, and quite some time after that before my brother and I were over taken by sleep.  

 

There are times when we tell stories through our writing and journaling, and times when each of us 

is our only audience with those mediums. That’s certainly fine, too, though I urge ensuring our 

writings, diaries, and journals live well beyond our years. Our stories are what our grandchildren, 

and their grandchildren for generations will treasure about us and possibly the best part of what 

they will know about us. I like writing short snippets, since that makes it easier for me to stay in 

the habit of writing something every day. Most don’t see my writings, that part of my “storytelling,” 

but I have taken care that they will be easily found and at least initially appreciated upon my 

demise. One snippet, one story, that I have shared before in gatherings and presentations on living 

memory and storytelling is below.  

 

“I awoke to a strong wind--I heard it creak the rafters in the house. I got up, walked down the hall, 

and looked out the kitchen window. I took a second, longer look--very surprised to see a near-

perfectly-still early-morning night in the shrubs and trees. I quietly walked toward the back of the 

house, wondering what I had mistakenly attributed to the wind. Moments later, the phone rang. And 

I knew--I just knew--before I answered that Charlie had passed. I picked it up and heard Tom 

simply say, “He’s gone.” I realized then the strong wind was Charlie stopping by one last time . . . to 

see if we were okay . . . or to say good-bye. I don’t know which right now, but I plan on asking him 

some day . . .”  

 

Of course, there can be many levels to, and numerous audiences for, nearly any story. It’s yet 

another thing about story that makes it golden. Not only what happened, but our beliefs and 

innermost feelings about those happenings can be expressed and shared. In the preservation article 

further on in this ezine, you can get ideas for using story as gifts. Here’s to giving and receiving the 

wonderful gift of story during the many holidays we will celebrate during the next several months. 

 

*************************************** 

Marching On . . . 

by Curt B. Witcher 

*************************************** 

In April of this year, I offered the challenge that everyone do at least one thing each month, 

Memorial Day through Veterans’ Day, to document and honor those who have served or are serving 

in the military. And here we are, nearly at Veterans’ Day 2014. I hope you have found this little 



challenge enjoyable, inspiring, and perhaps even a little motivating. It is my aspiration that engaging 

in this activity will have made “leaving no one behind” such a regular part of what we do that we will 

naturally just continue the activity well into the future.  

 

For as much as has been written on nearly every military engagement in the history of this great 

country, there are still so many more stories waiting to be discovered, written, and told. There are 

still regiments that participated in the War Between the States, for example, about which histories 

have not been written. And there are numerous companies and regiments for which more detailed 

and robust histories are needed.  

 

This past month saw several more military offerings added to The Genealogy Center’s “Our Military 

Heritage” online collection.  

 “Battery Adjust” is a brief history of the 899th Field Artillery Battalion in World War II from 

November 1944 to May 30, 1945. This battalion was part of the 75th Infantry Division. We are 

grateful to Ray Rhoads of Hendersonville, North Carolina for making this work available. 

www.GenealogyCenter.info/military/wwii/search_batteryadjust.php 

 

We thank Jeannette Maxey who contributed biographical sketches of Civil War veterans, William 

Willis of the 84th Illinois Infantry and the 7th Illinois Cavalry, and Orrin C. Tooker of the 15th 

United States Regular Army Infantry.  

www.GenealogyCenter.info/military/civilwar/viewpage_williamwillis.php 

www.GenealogyCenter.info/military/civilwar/viewpage_orrintooker.php 

 

Continue to honor; continue to leave no one behind. 

 

*************************************** 

The Great Arizona Orphan Abduction 

by Delia Bourne 

*************************************** 

Most genealogists are familiar with the history of Orphan Trains in America. In the mid-19th 

century, some reformers believed that orphaned or indigent children in eastern cities would thrive 

in the wholesome outdoors of the mid- and far West, bringing joy to new families and finding love 

and a supportive family in the process. Of course, like many plans, this one often fell far short of 

ideal. Children were regularly taken in by those who wished to exploit them for free labor or worse, 

some children were removed from loving, albeit impoverished, families, and siblings were separated 

at train stops along the way. The Orphan Train Riders have formed organizations to aid them in 

uncovering records that can provide information about birth families and backgrounds, and to 

provide emotional support to those affected by this process. The best known of the reform 

societies that sent orphans west was the Children’s Aid Society. Though the Society was a 

Protestant group, many of the Riders were actually of Irish descent and Roman Catholics.  

 

The Catholic Sisters of Charity of the New York Foundling Hospital had a similar outplacement 

process, but instead of shipping the orphans west hoping to locate families willing to take them, 

placements were arranged in advance in families that had been interviewed and approved by the 

local priests. To the Sisters, the local priests and G. Whitney Swayne, their western placement 

agent, the biggest issue was placing the children in Catholic homes, where their faith would be 



nurtured. Although the New York Foundling Hospital did not specifically classify by race, race did 

play a part, and these racial divisions identified Blacks, Poles and Irish as separate identities.  

 

In “The Great Arizona Orphan Abduction” (979.102 C61g), author Linda Gordon highlights these 

issues in recounting an incident when race and religion clashed over what was best for a group of 

waifs. 

 

On October 1, 1904, several nuns, Swayne and a group of mostly Irish orphans arrived in Clifton, 

Arizona. The orphans were to be placed in homes that had been pre-selected by the local parish 

priest, a French missionary. Most of the homes for which the children were destined were Mexican 

households, selected because the parents were educated and more economically advanced than 

their neighbors. In the anti-Irish atmosphere of the east, these were not white orphans, but Irish 

Catholic. To the children’s guardians, faith was the most important issue. 

 

The travelers were welcomed at the station by the local priest and church women, but there were 

many Anglo women who, having read about orphan trains, assumed they could just pick one of the 

light-skinned children on the train for their own. They were not pleased to be told that the children 

were already assigned, primarily to the Mexican families waiting on the outskirts of the crowd. 

 

Over the next 36 hours, tensions rose as some children were claimed by their pre-selected families. 

The Sisters tried to resist interference by the local Anglo community, but eventually convinced 

that the dissimilarity between children and families might be too great, they contemplated 

returning to New York with the children. Matters were removed from their control when a vigilance 

committee was formed and some of the children were removed/kidnapped from the Catholic homes 

to which they had been assigned, giving the children over to white, mostly Protestant families. 

 

Legal difficulties followed when the Protestant families ran into trouble adopting the children 

without the permission of their legal guardians, the Sisters of Charity, resulting in a lawsuit that 

went to the Arizona Supreme Court. The situation played out in the country’s newspapers.  

 

This is a fascinating volume, and Gordon has set the incident within the historical context of the 

time period and specifically to the region in which company versus labor was an ongoing conflict. It 

is an enlightening account for anyone interested in the time. 

 

*************************************** 

In Motion: The African-American Migration Experience 

by Melissa Tennant 

*************************************** 

When researching migration patterns for African-Americans, it is difficult to fully comprehend the 

complexities surrounding the transitory movements that African-Americans established when 

forging across America. The transatlantic slave trade during the colonial era, the domestic slave 

trade of the 19th century, and the urban development of the 20th century were dictated by 

uniquely different factors that led to a distinctive set of migration patterns specific to African-

Americans. These migration experiences are documented on The Schomburg Center for Research in 

Black Culture’s website “In Motion: The African-American Migration Experience,” 

www.InMotionAAME.org/. 



 

With more than 16,500 text pages, 8,300 images, and 60 maps, “In Motion” documents the African-

American experience from the 1450s to current day. The website focuses on thirteen specific 

migration patterns: Transatlantic Slave Trade (1450s-1867); Runaway Journeys (1630s-1865); 

Domestic Slave Trade (1760s-1865); Colonization & Emigration (1783-1910s); Haitian: 18th & 19th 

Centuries (1791-1809) and 20th Century (1970-present); Western (1840s-1970); Northern (1840s-

1890); Great Migration (1916-1930) and Second Great Migration (1940-1970); Caribbean (1900-

present); African (1970-present); and Return South Migration (1970-present). Access to the 

collections can be cross-referenced by browsing the migration, geography, and timeline categories 

or by searching by phrase or keyword. 

 

Each migration pattern featured on the site includes articles, letters, narratives, and other source 

materials describing the motivations and factors involved with the movement. Images reveal those 

who became plantation workers, settlers, miners, and more, while chronicling their resettlement in 

the different regions and eras. Maps highlight the unique patterns formed by African-Americans 

relocating across America and the Caribbean. Lesson plans for each topic are available for 

instructors. 

 

“In Motion: The African-American Migration Experience” is an informative resource for anyone 

researching African-Americans, since it details the historical significance and impact of these 

migration patterns. The graphics component of the website provides the user a visually stimulating 

way to learn more about the exceptional African-American migration experience. 

 

*************************************** 

Technology Tip of the Month--More from the Big PowerPoint Book – Creating an Outline 

by Kay Spears 

*************************************** 

Sometimes when you give a presentation, you may find it necessary or desirable to have an outline 

to pass out to your audience. 

  

First of all, there are a variety of options available from PowerPoint presentations to use as 

handouts. I have been to numerous presentations where I have been handed a semi-duplicate of the 

slide show, with lines beside the images and I can use those to take notes. This option is located on 

the menu File>Slides. If you select Slides, you should see numerous options in the drop-down menu. 

One of them is “three slides.” This option has the lines for taking notes. 

  

Outline method Number 2 is to Go to the View tab and in the presentation group, click Normal. If 

you have your slide pane open, you will see that in addition to the slide tab, there is also an outline 

tab. Click on it. Next, go to File>Print>Settings>Slides and you should see Outline in that dialog box. 

Click on it to print an outline. 

  

The third outline option has numerous choices. Go to Save/Send>Create Handouts> and click on the 

Create Handouts button. A dialog box with five options opens up. The options are: Notes Next to 

Slide, Blank Lines Next to Slides, Notes Below Slides, Blank Lines Below Slides, Outline Only. Chose 

one. These will be exported into a Microsoft Word document. 

  



As far as I know these are all of the outline options, however, one never knows, does one? 

  

Next month: More from the Big PowerPoint Book – The Difference Between Transition and 

Animation. 

 

*************************************** 

Quick-Tip of the Month for Preservation--Consider Family History-Related Gifts this Holiday 

Season 

*************************************** 

As the holidays approach, consider giving those hard-to-buy-for individuals in your family a family 

history-related gift. This might be something they treasure more than anything that could be 

purchased in a store, and it serves the double purpose of preserving family history at the same 

time. 

 

Photo albums or scrapbooks are family history-related gifts that can be excellent preservation 

projects for important photos. Besides preserving the actual photos or good quality copies of the 

images, they can ensure that the identification of who is in those photos is passed down to 

subsequent generations. Scrapbooks also can be a place to record memories of the individuals or 

events in the pictures. They do not have to be elaborately-decorated like the ones featured in 

magazines about the craft. Scrapbooking your photos can be as simple as using adhesive to attach 

the pictures to the pages, making sure to use all photo-safe materials, and identifying the 

individuals and events by writing on the pages around the photos. Or you can choose photo-safe 

albums with clear sleeves in pre-set sizes that fit the individual photos. Consider using some of the 

sleeve pockets to hold paper or cards with written information about the photos.  

 

Another possible family history holiday gift might be to record your personal memories for the 

younger members of the family. There are many ways to do this. You can write on paper in your own 

handwriting, type a document in a word processing program on the computer, or create a series of 

index cards in a box, each one holding a specific memory and categorized with dividers. You might 

choose to audio- or video-record yourself telling family stories or relating memories. A related idea 

is to video-record family heirlooms and tell the stories behind each one or, better yet, have 

someone record you pointing out or holding each object and describing it, telling who it belonged to 

and any associated stories.  

 

Give your loved ones the gift of their heritage this holiday season. As these kinds of gifts take 

time, start today. 

 

*************************************** 

WinterTech Time!  
*************************************** 

Whether it’s driven by the all the data and documents we collected during a summer of research 

and reunions, or the falling temperatures, falling leaves, and falling snow, it seems like many things 

entice us to spend more time indoors this time of year. And that means it must be time for The 

Genealogy Center to offer its series of WinterTech programs. The Genealogy Center has a great 

series planned this wintery season. We start off with “Basics of Adobe Elements,” on Monday, 

November 3, 2014, and Monday, November 10, 2014, 6:30 to 8:30 p.m. in the Computer Classroom at 



the Main Library. This two-part class, conducted by Kay Spears, will be devoted to learning the 

basics of using Adobe Elements. In it you will discover how to restore images of old photographs 

using techniques similar to those in Adobe Photoshop. Participants are encouraged to bring copies of 

their own family photographs on a USB (“flash”) drive for hands-on instruction in applying what they 

have learned to their personal photos. Space is limited. Email Genealogy@ACPL.Info or call 260-

421-1225 to register for these free events. Copies of photos must be on a USB (“flash”) drive. 

 

WinterTech will continue on December 10, 2014, with “Google It! Using Google Maps, Google Earth 

and More” from 3 to 4 p.m., with John Beatty and Dawne Slater-Putt. On January 14, 2015, 3 to 4 

p.m., Aaron Smith and Melissa Tennant will conduct a “Catalog Tour,” and Delia Bourne will wrap up 

the series on February 11, 2015, 3 to 4 p.m., with “Linkpendium & Mocavo: Using Free Genealogy-

Specific Search Engines.” Mark your calendar to take advantage of these classes! 

 

*************************************** 

Area Calendar of Events 

*************************************** 

The History Center 

1-2 November 2014--Miami Indian Heritage Days, Chief Richardville House, 5705 Bluffton Road, 

Fort Wayne, Indiana, 10 a.m.-5 p.m., November 1; noon-4 p.m. November 2. Program: Traders Days. 

Traditional Miami and regional tribes’ crafts, goods and wares for sale, hands-on demonstrations 

and interactive educational programs. Free to public. 

 

The History Center  

2 November 2014--George Mather Lecture Series, 302 East Berry, Fort Wayne, Indiana, 2 p.m. 

Ruth Ann Ingraham will present “’Cap’ Cornish, Indiana Pilot: Navigating the Century of Flight.” 

Lecture & book signing. 

 

Mary Penrose Wayne Chapter of the NSDAR 

8 November 2014--DAR Research Help, Allen County Public Library Genealogy Center, 900 Library 

Plaza, Fort Wayne, Indiana, 9 a.m.-noon. The Mary Penrose Wayne Chapter of the National Society 

of Daughters of the American Revolution (DAR) is available to help prospective DAR members 

research their lineage to prove ancestry to an American Revolutionary Patriot. 

 

Allen County Genealogical Society of Indiana Meeting 

12 November 2014--Allen County Public Library, 900 Library Plaza, Fort Wayne, Indiana, 7 p.m. Kelli 

Bergheimer will present “Clear the Mess from Your Desk.” 

 

Allen County Genealogical Society of Indiana Technology Group Meeting 

19 November 2014--Allen County Public Library, 900 Library Plaza, Fort Wayne, Indiana, 7 p.m. 

 

The History Center 

28 November-14 December 2014--Gingerbread Festival, 302 East Berry, Fort Wayne, Indiana. 10 

a.m.-5 p.m., Mondays-Fridays; noon-5 p.m. Saturdays; noon-5 p.m. first Sunday of the month. 

 

Historic Fort Wayne  

29 November 2014--Christmas at the Fort, 1201 Spy Run Ave., Fort Wayne, Indiana. 11 a.m.-5 p.m. 



 

*************************************** 

Driving Directions to the Library 

*************************************** 

Wondering how to get to the library?  Our location is 900 Library Plaza, Fort Wayne, Indiana, in the 

block bordered on the south by Washington Boulevard, the west by Ewing Street, the north by 

Wayne Street, and the east by the Library Plaza, formerly Webster Street.  We would enjoy having 

you visit the Genealogy Center. 

 

To get directions from your exact location to 900 Library Plaza, Fort Wayne, Indiana, visit this link 

at MapQuest: 

http://www.mapquest.com/maps/map.adp?formtype=address&addtohistory=&address=900%20Web

ster%20St&city=Fort%20Wayne&state=IN&zipcode=46802%2d3602&country=US&geodiff=1  

 

>From the South 

Exit Interstate 69 at exit 102.  Drive east on Jefferson Boulevard into downtown. Turn left on 

Ewing Street. The Library is one block north, at Ewing Street and Washington Boulevard. 

 

Using US 27: 

US 27 turns into Lafayette Street. Drive north into downtown. Turn left at Washington Boulevard 

and go five blocks. The Library will be on the right. 

 

>From the North 

Exit Interstate 69 at exit 112.  Drive south on Coldwater Road, which merges into Clinton Street.  

Continue south on Clinton to Washington Boulevard. Turn right on Washington and go three blocks. 

The Library will be on the right. 

 

>From the West 

Using US 30: 

Drive into town on US 30.  US 30 turns into Goshen Ave. which dead-ends at West State Blvd.  

Make an angled left turn onto West State Blvd.  Turn right on Wells Street.  Go south on Wells to 

Wayne Street.  Turn left on Wayne Street.  The Library will be in the second block on the right. 

 

Using US 24: 

After crossing under Interstate 69, follow the same directions as from the South. 

 

>From the East 

Follow US 30/then 930 into and through New Haven, under an overpass into downtown Fort Wayne.  

You will be on Washington Blvd. when you get into downtown.  Library Plaza will be on the right. 

 

*************************************** 

Parking at the Library 

*************************************** 

At the Library, underground parking can be accessed from Wayne Street. Other library parking 

lots are at Washington and Webster, and Wayne and Webster. Hourly parking is $1 per hour with a 

$7 maximum. ACPL library card holders may use their cards to validate the parking ticket at the 



west end of the Great Hall of the Library. Out of county residents may purchase a subscription 

card with proof of identification and residence. The current fee for an Individual Subscription Card 

is $70. 

 

Public lots are located at the corner of Ewing and Wayne Streets ($1 each for the first two half-

hours, $1 per hour after, with a $4 per day maximum) and the corner of Jefferson Boulevard and 

Harrison Street ($3 per day). 

 

Street (metered) parking on Ewing and Wayne Streets. On the street you plug the meters 8am – 

5pm, weekdays only.  It is free to park on the street after 5pm and on the weekends. 

 

Visitor center/Grand Wayne Center garage at Washington and Clinton Streets. This is the Hilton 

Hotel parking lot that also serves as a day parking garage.  For hourly parking, 7am – 11 pm, charges 

are .50 for the first 45 minutes, then $1.00 per hour.  There is a flat $2.00 fee between 5pm and 

11pm. 

 

*************************************** 

Genealogy Center Queries 

*************************************** 

The Genealogy Center hopes you find this newsletter interesting.  Thank you for subscribing.  We 

cannot, however, answer personal research emails written to the e-zine address.  The department 

houses a Research Center that makes photocopies and conducts research for a fee.   

 

If you have a general question about our collection, or are interested in the Research Center, please 

telephone the library and speak to a librarian who will be glad to answer your general questions or 

send you a research center form.  Our telephone number is 260-421-1225.  If you’d like to email a 

general information question about the department, please email: Genealogy@ACPL.Info. 

 

*************************************** 

Publishing Note:   

*************************************** 

This electronic newsletter is published by the Allen County Public Library's Genealogy Center, and 

is intended to enlighten readers about genealogical research methods as well as inform them about 

the vast resources of the Allen County Public Library.  We welcome the wide distribution of this 

newsletter and encourage readers to forward it to their friends and societies.  All precautions have 

been made to avoid errors.  However, the publisher does not assume any liability to any party for 

any loss or damage caused by errors or omissions, no matter the cause.   

 

To subscribe to “Genealogy Gems,” simply use your browser to go to the website:  

www.GenealogyCenter.org. Scroll to the bottom, click on E-zine, and fill out the form. You will be 

notified with a confirmation email. 

 

If you do not want to receive this e-zine, please follow the link at the very bottom of the issue of 

Genealogy Gems you just received or send an email to kspears@acpl.lib.in.us with "unsubscribe e-

zine" in the subject line.  

 



Dawne Slater-Putt, CG & Curt Witcher, co-editors 


